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Altech Smart Relay  provides the right solution for all your control needs! 

Providing excellent performance and functionality, Altech Smart Relay performs simple logic, timing, counting, and real time clock 
operations. It is an ideal programmable controller for simple control applications such as building construction equipments, HVAC, parking 
lot lighting and other applications in which cost is a primary design issue. All programming and data adjustments can be done via the on-board 
keypad and display or with the help of a software.

Programming Altech Smart Relay with the help of ASR-Soft configuration software is quite simple, without particular programming 
knowledge. It facilitates program generation, project simulation and documentation which are accomplished simply using the pick and place 
functionality, allowing maximum ease of operation. 

Ÿ   Integrated, ready to use, wide range of programmable functions including 16 timers, 16 (retentive 
     selectable) counters, 16 time switches, 16 compare counters, 16 soft text messages, 64 
     auxiliary relays and 12 analog comparators.

Ÿ   8 digital inputs & 4 relay outputs . Two analog inputs (0 -10V) in 12 -24VDC, model which can be   
     used  as digital inputs.

Ÿ   Ability to add up to three(3) extension modules expanding I/O’s to 32 digital inputs, 16 relay outputs. 

Ÿ   Communication module allows programmable relay to be connected to a Modbus network through 
     RS 485 link

Ÿ   Backlit LCD screen for display and modification of pre-selected parameters of function blocks, 
     viewing I/O status and programming on the device .

Ÿ   Ladder programming using software on PC as well on the device with the help of keypad & LCD Display 

Ÿ   Memory back up allowing programs to be transferred or copied into another Altech Smart Relay with the
     help of a memory card.

Ÿ   Compact size –only 72mm (2-53/64") wide x 90mm(3-35/64”) high x 65 mm (2-9/16) deep, reducing 
     panel area requirements for lower installed costs.

Ÿ   Soft keys for convenient creation and editing of programs on the device.

Ÿ   Available in both: AC(110 - 240 VAC) & DC(12 - 24 VDC) models.

Ÿ   Password & Parameter lock facility. 

Some of its features are:

Approvals

Ÿ Extension Module can be used with base module to increase I/O capacity of Altech Smart Relay. 

Ÿ Every extension module has 8 digital inputs & 4 digital outputs. 

Ÿ Connections are made in Daisy chain fashion. 

Ÿ Altech Smart Relay can be expanded by connecting 3 extension modules, to obtain a maximum 
configuration of 32 inputs and 16 outputs.

EXTENSION MODULE

ACCESSORIES

COMMUNICATION MODULE  RS 485

Memory Card

Ÿ    RS 485 provides Modbus communication for Altech Smart Relay. 

Ÿ    Possible to connect multiple Altech Smart Relay’s with a SCADA system or a HMI over RS 485. 

Ÿ    Available in both AC (110 - 240 VAC ) & DC (12 - 24 VDC) models.  

Serial Cable

Communication Module

Communication Cable

Extension Module

Base Module

USB Cable

RoHS Compliant

Introduction
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 The 8 keys located on the front facia of Altech Smart Relay are used to configure, program and control the 
application. 

FRONT VIEW OF KEYPAD & FUNCTIONS OF KEYS

This key is used to delete a program element or a blank line, if the cursor is located at the extreme column.

DEL

This key is used for selecting/exiting a parameter in the edit mode and to show either the Parameters or Program 
while the program is running. This feature is also useful for debugging.

ALT

On the program editor screen, the arrow keys are used to move up, left, down and right. The position on screen is shown by a cursor or 
blinking text. They are used as push buttons to get signals from user. If  user goes into PAR (parameter mode), then these keys are not 
available as z-keys. At that time these keys are used as arrow keys.

Z (ARROW) Keys 

This key is used to exit the menu or a selection. During the parameter entry it proceeds to the next parameter without saving the changes.

ESC

This key to is used to insert a program line, when cursor is blinking in the first column of first row. During the 
parameter entry while editing this key saves the changes and proceeds to next parameter. In RUN mode, this key 
can be used to select one of the 3 displays. This also selects/deselects links.

OK
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Wiring Diagrams
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Power Supply Wiring

Wiring of Input/Ouput

1. Although the Altech Smart Relay has been designed to withstand the negative effects of any electrical noise that might be present in the incoming power supply it may 
be necessary to insert an isolation transformer between the supply and the line terminals of the Altech Smart Relay. 
2. While using the DC Altech Smart Relay, run the 24 VDC Input line away from the 100 V AC and 200 V AC lines. 

1. Separate the Input lines and output. 
2. When the output lines are running close to power supply lines or the Input lines use batch shielded and ground them.

Fig. 3 Fig. 4

Fig. 2Fig. 1

SUPPLY, INPUT & OUTPUT CONNECTIONS

AC Base Module AC Extension Module DC Base Module DC Extension Module
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485DC
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Programming and other settings in Altech Smart Relay can be done using the  
software as well as on the device itself with the help of the keypad & display.

When the connections are made and the device is powered ON, screen 1 is 
displayed on the device. By default the cursor will blink on the ‘PROGRAM’ 
option. Using the Up, Down keys, user can select between any of the options.

When the cursor is on the PROGRAM option and OK key is pressed, then 
screen 2 is displayed.

When screen 2 is being displayed, the cursor is on the ‘EDIT’ option.
Press the OK key to enter this option & screen 6 will be displayed. Similarly 
by pressing down key and OK, one can enter the other functions viz. 
“DELETE”, “TRANSFER”, “MODBUS CONF” and screen 7,8 and 9 will be 
displayed respectively 

When the cursor is on the UTILITIES option and OK key is pressed, then 
screen 5 is displayed.

When screen 5 is being displayed, the cursor is on the ‘SET CLOCK’ option.
Press the OK key to enter this option & screen 1 will be displayed. Similarly 
by pressing down key and OK, one can enter the other functions viz. 
“PASSWORD”, “EXT MOD”, “BACKLIT CONF” and screen 7,8 and 9 will 
be displayed respectively 

The CONTINUE Mode does not change the states of the Inputs/Outputs and 
special functions and continues with the execution of the program.

The RESET Mode resets all the previous states of Inputs/Outputs, clears 
timer and counter states, starts afresh.

This function displays and allows the user to change parameters of special 
functions like timer, counter, Time switch (clock), compare counters and 
analog functions used in the program. This may be password protected and 
may have additional individual lock for each parameter.
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This function allows the user to enter a new program or edit an existing 
program. If Password is set, then this function is accessible only with the 
correct password.

This function will set Mod bus Slave configuration data.
The user can set the following communication parameters:
ŸSLAVE ID , BAUD RATE, PARITY , STOP BIT 

This function is used to set the day and time: Day of the week, Date, Hours-
Minutes. This function is available only on  Altech  Smart Relay.

This function allows the selection of the Extension Modules (A/B/C). 
Maximum 3 Extension Modules can be connected to the Altech Smart 
Relay’s Main Unit. In  the  ASR-Soft on PC, extension modules have to be 
chosen using the "Configuration" menu. 

This function allows the setting of backlight in either On, Off or Auto mode. 
In the Auto mode, the backlight comes up only when a key is pressed on the 
device and remains for 10 seconds. If the ON or OFF modes are selected the 
backlight will be permanently ON or OFF respectively.

This function allows setting of password. If password is set, certain functions 
like Program, Parameters are protected and are accessible only when correct 
password is entered. The Password can be set or removed; the status is 
indicated by the open or closed lock symbol.

This function will transfer the program from device to memory card or vice 
versa. Program data on memory can also be deleted in this mode.

This function will clear the entire program stored in the Altech Smart Relay. If 
password is set, then this function will work only with correct password.

Programming the Altech Smart Relay at the Device: Menu & Functions

Screen 1 Screen 2 Screen 6

Screen 7

Screen 8

Screen 9

Screen 10

Screen 11

Screen 12

Screen 13

Screen 3

Screen 4

Screen 5

When screen 1 is being displayed, press the down key to shift the cursor to the 
RUN option and press OK key to enter it. Screen 3 will be displayed.

When the cursor is on PARAMETERS option and OK is pressed then screen 4  
will be displayed.

SET CLOCK

PASSWORD

EXTENSION MODULE

BACKLIT CONF

EDIT

DELETE

TRANSFER

MODBUS CONFIG

RESET

CONTINUE

PARAMETERS
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Altech Smart Relay provides 2 types of Inputs viz. 
AC Model: Digital Inputs (1 - 8) 
DC Model: Digital Inputs (1 - 6), Analog Inputs (V1, V2)8

Digital & Analog

INPUTS

TIMERS

Q1, Q2, ..... Q4 Base Module 

Extension Module 3

Extension Module 2

Extension Module 1Normally Open 
Contact

(’NO’ Contact)

U1, U2, ..... U4

V1, V2, ..... V4

W1, W2, ..... W4

q1, q2, ..... q4 Base Module 

Extension Module 3

Extension Module 2

Extension Module 1Normally Closed 
Contact

(’NC’ Contact)

u1, u2, ..... u4

v1, v2, ..... v4

w1, w2, ..... w4

Altech Smart Relay provides Base Module (4), Extension 
Module (4)
The outputs can be configured as: 
I. State Change (Contactor), ii. Level Change (Remote Control), iii. Bi-stable 
(Set Reset)

Digital Outputs: 
OUTPUTS

I1, I2, ..... I8 Base Module 

Extension Module 3

Extension Module 2

Extension Module 1Normally Open 
Contact

(’NO’ Contact)

J1, J2, ..... J8

K1, K2, ..... K8

L1, L2, ..... L8

i1, i2, ..... i8 Base Module 

Extension Module 3

Extension Module 2

Extension Module 1Normally Closed 
Contact

(’NC’ Contact)

j1, j2, ..... j8

k1, k2, ..... k8

l1, l2, ..... l8

Altech Smart Relay 16 Soft Text Message blocks which can be 
used to display text messages, the Preset Value and Current Value of any 
Special Function Block or the Current Date and time

 provides 

SOFT TEXT MESSAGES

X1, X2, ..... X16 Used for viewing Alarms, HMI Functionality

Altech Smart Relay 16 Timers which can be configured as:
I. ON Delay, ii. Off Delay, iii. Single Pulse iv. Symmetric/Asymmetric

 provides 

v. Equal/Unequal On/Off 2, vi. Equal/Unequal Off/On 2,
vii. Leading Edge Impulse 1, viii. Leading Edge Impulse 2
ix. Trailing Edge Impulse 1, x. Trailing Edge Impulse 2 
xi. Delayed Impulse, xii. Impulse On/Off, xiii. Signal Off/On.   

T1, T2, ..... T16

t1, t2, ..... t16

Timer Coil / Normally Open (NO) Contact

Normally Closed (NC) Contact
Trigger Input

Timer Mode

Locked/Unlocked State
Make/Break Status of ‘NO’ Contact

Preset Time Period

Current Time Period

Timer Number

Preset Time Unit

Current Time Unit

Reset Input
  D      TRG        T1
           RES        X
  S      000.0       OF
  S      006.0       OF

  D      TRG        T1
           RES        X
  S      000.0       OF
  S      006.0       OF

Altech Smart Relay 16 Time Switches which can be used for daily or 
weekly applications

 provides 

TIME SWITCHES

 1,   2, .....   16

 1,   2, .....  16

Normally Open (NO) Contact

Normally Closed (NC) Contact

  D      TRG        T1
           RES        X
  S      000.0       OF
  S      006.0       OF

         MO   SU        
          08 :  11         1
ON     09 :  15     X
OFF   12 :  00    

From To

Time Switch No

Make/Break Status 
of ‘NO’ Contact

Locked/Unlocked State

Start Time

End Time 

Current Time

Altech Smart Relay 16 Compare Counters which can be used for 
comparison between values of two counters or between a counter and any 
absolute value
I. Up Counter, ii. Down Counter

 provides 

COMPARE COUNTERS

P1, P2, ..... P16

p1, p2, ..... p16

Normally Open (NO) Contact

Normally Closed (NC) Contact

  D      TRG        T1
           RES        X
  S      000.0       OF
  S      006.0       OF

        COMPARE      
C1         0000
                >           P1   
ABS      1023        X   

Make/Break Status of ‘NO’ Contact

Compare Counter No

Locked/Unlocked State

Compare Function

Absolute Value 

Compare Input

Altech Smart Relay 12 Analog Comparators which can be used 
for comparison between values of two analog signals or between a an 
analog signal and any absolute value

 provides 

ANALOG COMPARATORS

A1, A2, ..... A12

a1, a2, ..... a12

Normally Open (NO) Contact

Normally Closed (NC) Contact

  D      TRG        T1
           RES        X
  S      000.0       OF
  S      006.0       OF

          ANALOG      
V1         0000
                >           P1   
ABS      1023        X   

Make/Break Status of ‘NO’ Contact

Analog Comparator No

Locked/Unlocked State

Compare Function

Absolute Value 

Compare Input

Altech Smart Relay 64 Auxiliary relays which can be used to expand a 
rung from one line to another line.
It can be configured as: 
I. State Change (Contactor), ii. Level Change (Remote Control), iii. Bi-stable 
(Set Reset)

 provides 
AUXILIARY RELAYS

M1, M2, ....M64

m1, m2, .....m64

Auxiliary Coil / Normally Open (NO) Contact

Normally Closed (NC) Contact

Altech Smart Relay 16 Counters which can be configured as:
I. Up Counter, ii. Down Counter

 provides 

Z-Keys are navigation keys provided on device front facia.They behave 
exactly like the physical inputs (Discrete inputs). The only difference is 
that they do not correspond to Altech smart relay connection terminals, but 
to the four gray buttons on the front panel.

·Z-Keys can be used as navigation keys for current displayed menu. 
To use Z-Keys go to RUN Screen or RUN LADDER Screen and Press 
ALT which will display the Z-Key Screen. Then Press Z1 - Z4.

COUNTERS

Z-KEYS

C1, C2, ..... C16

c1, c2, ..... c16

Counter Coil / Normally Open (NO) Contact

Normally Closed (NC) Contact

Z1, Z2, ..... Z4

z1, z2, ..... z4

Normally Open (NO) Contact

Normally Closed (NC) Contact

  D      TRG        T1
           RES        X
  S      000.0       OF
  S      006.0       OF

           0004      0000          
            DIR        RET
            CNT     C1  N
            RES      X

Preset Value

Locked/Unlocked State
Make/Break Status
 of ‘NO’ Contact

Retentive Selection (Y/N)

Current Value

Counter Number

Counter Unit

Reset Unit

Direction Input

Ladder Programming Elements / Function Blocks
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In ladder programming, the ladder elements / Functional Blocks are connected to create a ladder for any application. The following section gives the description of 
each element that is used for ladder programming.



PASSWORD 
ENABLED     

Setting the Password
1. Select the “UTILITIES” option from the Main Menu and press OK.
2. Select the “PASSWORD” option from the Sub Menu and press OK.
3. The unlock symbol means that the password is not yet set.
3. The cursor will blink on the first digit of the date, press ALT to edit the digit 
4. The digit will now start blinking 
5. Using Up(Z4) and Down(Z2) keys select the appropriate digit.
6. Now press Z3 to edit the other digit and using Up & Down keys select the digit.
7. Repeat the same procedure to set all the 4 digits.
8. Now press OK to confirm the changes that have been made.
9. Again on pressing OK the password is enabled and the Main Menu is displayed

 IPROGRAM
RUN
PARAMETERS
UTILITIES     

 IPROGRAM
RUN
PARAMETERS
UTILITIES     

 ISET CLOCK
PASSWORD
EXT MOD
BACKLIT CON

OK ALT Z4

OKOK

PASSWORD      

7

PASSWORD      

77 22 55 77

PASSWORD      

77 22 55 77

 IPASSWORD      

PASSWORD 
ENABLED     

Removing the Password
1. Select the “UTILITIES” option from the Main Menu and press OK.
2. Select the “PASSWORD” option from the Sub Menu and press OK.
3. The lock symbol means that the password is set.
3. The cursor will be blink on the first digit, press ALT to edit the digit 
4. The digit will now start blinking 
5. Using Up(Z4) and Down(Z2) keys select the appropriate digit.
6. Now press Z3 to edit the other digit and using Up & Down keys select the digit.
7. Repeat the same procedure to set all the 4 digits.
8. Now press OK to confirm the changes that have been made.
9. Again on pressing OK the password is disabled and the Main Menu is displayed

 IPROGRAM
RUN
PARAMETERS
UTILITIES     

 ISET CLOCK
PASSWORD
EXT MOD
BACKLIT CON

OK ALT Z4

OKOK

PASSWORD      

7

PASSWORD      

77 22 55 77

PASSWORD      

77 22 55 77

 IPASSWORD      

Extension Module Selection
1. Select the “UTILITIES” option from the Main Menu and press OK.
2. Select the “EXT MOD” option from the Sub Menu and press OK.
3. The cursor will be blinking on ‘A’, press ALT to edit and the ‘A’ will start blinking. 
4. Press Up(Z4) or Down(Z2) keys to select or deselect the extension module.
5. A dark square around ‘A’ indicates that the module has been selected.
6. Now press OK to confirm the changes that have been made.
7. Repeat the same procedure if the other modules are to be selected.
8. Press OK to save  the changes and the ‘UTILITIES’ sub menu is displayed

If only one extension module is being used and it has been assigned as ‘A’ on the 
extension module using the selection switch then make sure that ‘A’ is selected in the 
‘EXT MOD’ option in the ‘UTILITIES’ menu. If more than one extension modules 
are being used then make sure that the modules have been assigned and selected 
appropriately because this in turn will affect the inputs and the outputs.

Backlit Configuration
1. Select the “UTILITIES” option from the Main Menu and press OK.
2. Select the “BACKLIT CONF” option from the Sub Menu and press OK.
3. The ‘Auto’ option will be displayed with the cursor blinking on it.
4. Press ALT to edit and the Auto option will start blinking. 
5. Press Up(Z4) or Down(Z2) keys to select other options viz. ON, OFF.
6. Now press OK to confirm the changes that have been made.
7. Press OK to save  the changes and the ‘UTILITIES’ sub menu is displayed.

Setting the Clock
1. Select the “UTILITIES” option from the Main Menu and press OK.
2. Select the “SET CLOCK” option from the Sub Menu and press OK.
3. The cursor will blink on the first digit of the date, press ALT to edit the digit 
4. The digit will now start blinking 
5. Using Up(Z4) and Down(Z2) keys select the appropriate digit.
6. Now press Z3 to edit the other digit and using Up & Down keys select the digit.
7. Now press OK to confirm the changes that have been made.
8. Repeat the same procedure to set the month, year, hour and minutes.
Once all the parameters have been set, pres OK to save the changes and exit. 

The password secures access to the following main menu options: 
"PROGRAM","PARAMETERS" and "UTILITIES".

The password comprises four numeric digits from 0 to 9. 
Therefore the password can have any value between 0 and 9999. 

 Password feature is disabled 
during Ladder Run Mode. User can view/edit SFB data during ladder Run mode if 
the "LOCK/UNLOCK" property is in unlock state. Edited at run time will not be 
saved permanently in the device. This functionality is provided only to test the 
system during run time. 

PASSWORD

OKOK

Functions
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ALT IPROGRAM
RUN
PARAMETERS
UTILITIES     

 ISET CLOCK
PASSWORD
EXT MOD
BACKLIT CON

 ISET CLOCK
PASSWORD
EXT MOD
BACKLIT CON

OK OK Z4 IEXTENSION 
MODULES

A        B       C

 IEXTENSION 
MODULES

A        B       C

 ISAVING DATA
. . . WAIT

 IEXTENSION 
MODULES

         B       CA

 IDD/MM/YY
11/01/11
HH:MM
09:30   

 IDD/MM/YY
15/01/11
HH:MM
09:30   

 IPROGRAM
RUN
PARAMETERS
UTILITIES     

 IDD/MM/YY
01/01/11
HH:MM
09:30   

 IDD/MM/YY
01/01/11
HH:MM
09:30   

 IDD/MM/YY
11/01/11
HH:MM
09:30   

 ISET CLOCK
PASSWORD
EXT MOD
BACKLIT CON

OK OK ALT Z4

Z4Z3  ISAVING DATA
. . . WAIT

ALT IPROGRAM
RUN
PARAMETERS
UTILITIES     

 ISET CLOCK
PASSWORD
EXT MOD
BACKLIT CON

OK OK Z4 I    BACKLIT
    CONFIG

      AUTO

 I    BACKLIT
    CONFIG

      AUTO

 I    BACKLIT
    CONFIG

      ON

 I    BACKLIT
    CONFIG

      ON

 ISET CLOCK
PASSWORD
EXT MOD
BACKLIT CON

 ISAVING DATA
. . . WAIT

AUTO:

ON:
OFF:

 In AUTO mode, whenever a key is pressed the backlit will be switched 
ON and will switched OFF after 10 seconds.

 In ON mode, the backlit will be permanently switched ON.
 In OFF mode, the backlit will be permanently switched ON.

Ladder Program Protection
1. If the password is already enabled and user attempts to gain access using 
wrong password, then an error message is displayed. 
2. If four such consecutive attempts are made then user is presented with options 
to either delete the entire device data or else revert. 
3. If the DELETE ALL option is selected , then all device data including 
Password and Ladder is erased. The user can then re program the Ladder using 
ASR-Soft and secure it with a new password. 

After four wrong attempts of entering the Password this Screen as shown below 
appears. Pressing OK here, will delete all device data. 

After four wrong attempts of entering the Password if user presses ESC ,the device 
will return to last menu mode from where it has entered in PASSWORD screen.

 IPASSWORD       IINITIALIZING
DEVICE DATA

. . . WAIT

 IDELETE ALL ?

 IPASSWORD      
 IINVALID
PASSWORD

... try later

OKOK

OK

 IPROGRAM
RUN
PARAMETERS
UTILITIES     



Deleting a Program Line

Move the cursor to the first column of the line, if necessary delete the elements one 
by one to create a blank line. Press DEL. The line is deleted.
It is also possible to delete the entire program stored in the Altech Smart Relay. To 
do this, call up the "DELETE" option in the Program menu and validate the deletion 
of all program lines.

Creating or Editing a Ladder

Replacing a Link with a Contact

To replace a link with a contact, simply place cursor at the required location and 
press ALT to enter the contact 

Changing an Element
To change an element in an existing program, simply move to the element to 
change, press ALT and follow the same procedure as when entering a new element

Deleting an Element

To delete an element, simply place the cursor on the required element, then press 
DEL. Generally, the deleted element must be replaced by a link

Deleting Links between Elements

To delete a link, simply move the cursor next to the desired position, press the OK 
key to change the cursor and press DEL key. This may delete some of the 
required connections, which may be restored by the same method as above

Inserting a Program Line

To insert a program line, simply move cursor to the first column of the line 
immediately above the one to create and press OK.

Entering a Link
1. Place the blinking cursor next to the desired location.
2. Press OK to start the link ("     ","cursor")
3. Move the cursor to the desired location using the arrow keys. 
4. As the cursor moves, the link is drawn.
5. Press OK to exit to normal mode.
6. Repeat this action as many times as necessary to link all the elements together as 
required

 

To create a new ladder or edit an existing ladder, select the PROGRAM option from 
the Main Menu by pressing OK. 
Select the EDIT option to create or edit a ladder. 

Editing Parameters of Special Function Blocks
Parameters of special Function Blocks can be modified in two modes
1. Run Mode 2. Program Stop Mode

Program Stop Mode
1.Place the cursor on PARAMETERS menu and Press OK.
2.Enter the PASSWORD if it has been enabled and press OK.
3.Set Parameters. Press OK.If user do press ESC key without pressing OK the 
screen as shown will appear, so that user can have three options as: 
EDIT: Again enter into parameter set mode. 
SAVE AND EXIT: Save the parameters & come out of mode. 
EXIT: Retain previous settings & come out of set mode.

Run Mode
1.

2. Press ‘OK’. Enter the PASSWORD if it has been enabled and Press OK. Special 
function block with it's parameters set will get display. 
3. Set parameters & press OK to save the parameters 
4. Press ESC to return Run Mode Menu . 
5. If user do not press OK and do press ESC previous settings retains & returns to  
Run Mode Menu.

User can enter into Run Time parameters. Press ESC to go on the PARAMETER 
RUN men  as shown below.

temporary.

 IPAUSE
STOP
PAR RUN
PROG RUN

 IPASSWORD      

 I 2            Q1
                 Q2

 I 1            Q1
                 Q2

 I 1            Q1
                 Q2

 I I 1            Q1
                 Q2

OK

 IPROGRAM
RUN
PARAMETERS
UTILITIES     

  D   TRG      T1
        RES      X
  S   000.0    OF
  S   006.0    OF

OK  IPROGRAM
RUN
PARAMETERS
UTILITIES     

 IEDIT
SAVE & EXIT
EXIT

OK

ESC

OK

Inserting a Coil
1. Place the blinking cursor in the required position.
2. Press ALT.
3. Choose the required element using the Up or Down keys.
4. Use the Right Arrow key to call-up the number.
5. Choose the number using Up or Down keys.
6. Use the Left Arrow key to move to the type of coil.
7. Choose the type of coil using Up or Down keys.
8. Press ALT or Right Arrow to accept and to go to next position.

 I 1          Q2
            

 I 1          Q2
            

 I 1          Q1
            

 I I 1          
                  

ALT ALTZ3

Z2

Inserting a Contact
1. Place the blinking cursor in the required position.
2. Press ALT.
3. Choose the required element using the Up or Down keys.
4. Use the Right Arrow key to move to the number.
5. Choose the number using up or down keys.
6. Press ALT or Right Arrow to accept and to go to next position.

 I 1 I I 1 I

 I 2 I 2 OK

Z3ALT Z4

Functions

8

Devie to Card

Card to Device

TRANSFER
The TRANSFER function allows data to be transferred from Memory Card to 
Altech Smart Relay or vice-versa. 
Transferring data to memory card is useful when user wants to load the same 
program in many Altech Smart Relay units. In this case instead of using PC user can 
make use of memory card, which is capable of storing one program. This feature is 
particularly useful on the production line where user is not required to edit and 
debug the program and a PC is not available. 

In this mode of transfer "PASSWORD"and "UTILITIES"such as  Backlight 
configuration & Extension module state will also get transferred with the program 
ladder.

1. Insert the Memory card in the connector 
2. Select the "TRANSFER" function from the "PROGRAM" menu.
3. Press the OK key to validate.
4. Select the Device > Card function.
5. Press the OK key to validate.

of Altech Smart Relay.

This transfer is used to reload an application into the Altech Smart Relay. It avoids 
the need to re-enter an existing application. 
1. Insert the Memory card in the connector after removing the serial cable, if 
present.
2. Move cursor to the "TRANSFER" function from the "PROGRAM" menu.
3. Press the OK key to validate.
4. Select the Card > Device function.
5. Press the OK key to validate.

 IPROGRAM
RUN
PARAMETERS
UTILITIES     

 IOKOK  IEDIT
DELETE
TRANSFER
MODBUS CON

CARD > DEVICE
DEVICE > CARD
DELETE CARD

 IPAUSE
STOP
PAR RUN
PROG RUN

 IPAUSE
STOP
PAR RUN
PROG RUN

  D   TRG      T1
        RES      X
  S   000.0    OF
  S   006.0    OF

OK ESC

OK  IPAUSE
STOP
PAR RUN
PROG RUN

  D   TRG      T1
        RES      X
  S   000.0    OF
  S   006.0    OF

OK ESC

  D   TRG      T1
        RES      X
  S   000.0    OF
  S   006.0    OF

 IEDIT
SAVE & EXIT
EXIT

 ISAVING DATA
. . . WAIT

OK

ESC

 IPASSWORD        D   TRG      T1
        RES      X
  S   000.0    OF
  S   006.0    OF

 IPROGRAM
RUN
PARAMETERS
UTILITIES     

OK OK



Functions

Run Mode Functions

If the CONTINUE option is selected then Ladder Program execution will proceed 
& the Run mode display screen will appear as shown 
If the RESET option is selected then all special function block parameters are 
initialized & the Run mode display screen will appear 

RUN MODE MODBUS SETTINGS

To enter into RUN mode select the "Run" option in the main menu and press 'OK'.

During the Run mode  the user can enter the Run Mode Functions by pressing the 
ESC key

Parameter Lock

Slave ID

Baud Rate

Stop Bits

Parity

 ICONTINUE
RESET

  I 12345678
                     SA
  Q 1234   08:30
  ESC

 IPROGRAM
RUN
PARAMETERS
UTILITIES     

 IPARAMETER
LOCKED    

PAUSE
If the PAUSE option is selected by pressing OK then program execution is paused. 
 And user can have two options as 

 Run with the parameters status it has or 
 Reset the parameters and run the program.

Continue:
Reset:

PROG RUN
·If the PROG RUN option is selected then the ladder program is displayed on the 
screen. The user cannot edit the program and can only go through the program by 
using UP,  Down keys 
 If Z-Keys are used in the program then pressing the ALT key will display the Z-Key 
screen. 

* Embedded parameters when unlocked and edited at run time will not be saved permanently in the device. This functionality is 
provided only to test the system during run time. To save parameters permanently, user has to stop the program, move to edit mode & 
configure the system accordingly.

 In Run Mode, extension module identities cannot be changedNote:

PAR RUN

·If the PAR RUN option is selected then Parameter edit window of Special Function 
Block is displayed. The user can edit the parameters by using ALT, UP, DOWN & 
OK keys.*  

STOP

If the STOP  option is selected by then the program execution is stopped & Main 
Menu is displayed on the screen.

 IPAUSE
STOP
PAR RUN
PROG RUN

 II1----------  Q1
I2----------  Q2
I3----------  Q3

 IZ1
Z2
Z3
Z4

  D   TRG      T1
        RES      X
  S   000.0    OF
  S   006.0    OF

 IPROGRAM
RUN
PARAMETERS
UTILITIES     

 IPAUSE
STOP
PAR RUN
PROG RUN

 IPAUSE
STOP
PAR RUN
PROG RUN

  I 12345678
                     SA
  Q 1234   08:30
  ESC

 IPAUSE
STOP
PAR RUN
PROG RUN

 ICONTINUE
RESET

  I 12345678
                     SA
  Q 1234   08:30
  ESC

 IPAUSE
STOP
PAR RUN
PROG RUN

 II1----------  Q1
I2----------  Q2
I3----------  Q3

When user edits parameter from text message and if parameter is locked then above screen 
appears. To change that parameter user has to edit that parameter in edit mode only.

OK OK

OKESC OK

OK

Z3

Z3

Z3

OK

OK
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1. Select the “PROGRAM” option from the Main Menu and press OK.
2. Select the “MODBUS CONF” option from the Sub Menu and press OK.
3. The cursor will blink on the first digit of the Salve ID (SLV ID).
4. Press ALT to edit the digit and the digit will now start blinking 
5. Using Up(Z4) and Down(Z2) keys select the appropriate digit.
6. Now press Z3 to edit the other digit and using Up & Down keys select the digit.
7. Now press OK to confirm the changes that have been made.

8.   Now press Z3 to select Baud Rate (BAUD) and press ALT to edit..
9.   Using Up(Z4) and Down(Z2) keys select the appropriate Baud Rate.
10. Now press OK to confirm the changes that have been made.

11. Now press Z3 to select ‘PARITY’ and press ALT to edit..
12. Using Up(Z4) and Down(Z2) keys select the appropriate parity.
13. Now press OK to confirm the changes that have been made.

14. Now press Z3 to select ‘STOPBIT’ and press ALT to edit..
15. Using Up(Z4) and Down(Z2) keys select the number of stop bits.
16. Now press OK to confirm the changes that have been made.

17. Once all the changes have been made press OK to save and exit.

 IPROGRAM
RUN
PARAMETERS
UTILITIES     

 ISLV ID      001
BAUD       9600
PARITY   NONE
STOPBIT    1

 ISLV ID      001
BAUD       9600
PARITY   NONE
STOPBIT    1

 ISLV ID      101
BAUD       9600
PARITY   NONE
STOPBIT    1

 ISLV ID      101
BAUD       9600
PARITY   NONE
STOPBIT    1

 ISLV ID      111
BAUD       9600
PARITY   NONE
STOPBIT    1

 ISLV ID      111
BAUD       9600
PARITY   NONE
STOPBIT    1

 IEDIT
DELETE
TRANSFER
MODBUS CON

OK OK

OK

ALT Z4

Z4Z3

 ISLV ID      101
BAUD       9600
PARITY   NONE
STOPBIT    1

 ISLV ID      111
BAUD       0300
PARITY   NONE
STOPBIT    1

 ISLV ID      111
BAUD       0300
PARITY   NONE
STOPBIT    1

 ISLV ID      111
BAUD       9600
PARITY   NONE
STOPBIT    1

OKZ4Z3

 ISLV ID      101
BAUD       9600
PARITY   NONE
STOPBIT    1

 ISLV ID      111
BAUD       0300
PARITY    ODD
STOPBIT    1

 ISLV ID      111
BAUD       0300
PARITY    ODD
STOPBIT    1

 ISLV ID      111
BAUD       0300
PARITY   NONE
STOPBIT    1

OKZ4Z3

 ISLV ID      111
BAUD       0300
PARITY    ODD
STOPBIT    1

 ISLV ID      111
BAUD       0300
PARITY    ODD
STOPBIT    1

 ISLV ID      111
BAUD       0300
PARITY    ODD
STOPBIT    2

 ISLV ID      111
BAUD       0300
PARITY    ODD
STOPBIT    2

OKZ4Z3

 IEDIT
DELETE
TRANSFER
MODBUS CON

 ISLV ID      111
BAUD       0300
PARITY    ODD
STOPBIT    2

 ISAVING DATA
. . . WAIT



 Installation on Windows  XP: 
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This section provides Instructions for installing the  ASR - Soft. 

The ASR – SOFT Installation Program creates directories as needed, creates files on your hard drive, and creates  ASR-Soft icon on your desktop.

Note: You must have Administrator privileges on your PC in order to install or uninstall the  software.

        Click on "Next" to start installation.
         A dialog box indicating the status of the progress of installation will display.

ASR-Soft Installation  

      Then Driver Installation window will display. Click on "Install" to start 

      installation.

After your PC has restarted, you can run the ASR –SOFT.

3

5

4

the screen “ASR-Soft  has been successfully installed ” will appear on your 
PC and  it restarts.  

When the Installation is finished, select “Yes" to restart your PC. After this, 6

7

When prompted for the destination directory as shown below, user can either 
select the default directory (C:\Program Files\Altech Smart Relay\ASR-
SOFT) or enter another destination directory for the installation files.

2Insert the ASR-soft CD into the CD-ROM drive of your computer/laptop. The 
installation wizard starts automatically and a Welcome screen appears, as 
shown below. In case the Auto run feature is disabled in your Windows  settings, 
use Windows  explorer to access the 'setup.msi' file. Double-click the  icon 
'setup.msi' and the welcome screen appears. 

     If you have downloaded the folder containing the ASR-Soft Setup then the 
installation process has to be done manually. For this, double-click the 
'setup.msi' file in the folder and continue the installation process once the 
Welcome screen appears.

         In the Welcome screen, click the Next button to continue.

1



Installation on Windows  Vista and Windows  7: 
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When prompted for the destination directory as shown below, user can either 
select the default directory (C:\Program Files\Altech Smart Relay\ASR-
SOFT) or enter another destination directory for the installation files.

ASR-Soft Installation  

Then Driver Installation window will display. Click on "Install" to

         start installation.

Restart your PC after installing the software, to complete the installation. After 
your PC has restarted, you can run the ASR –SOFT.

        Click on "Next" to start installation.3

5

7

2

         A dialog box indicating the status of the progress of installation will display.4

successful, will appear. Once we press OK, the screen “ASR-Soft has been 
successfully installed” will appear on your PC. 

When the Driver installation is finished, “Success” screen – Installation   6

Insert the ASR-soft CD into the CD-ROM drive of your computer/laptop. The 
installation wizard starts automatically and a Welcome screen appears, as 
shown below. In case the Auto run feature is disabled in your Windows  settings, 
use Windows  explorer to access the 'setup.msi' file. Double-click the  icon 
'setup.msi' and the welcome screen appears. 

     If you have downloaded the folder containing the ASR-Soft Setup then the 
installation process has to be done manually. For this, double-click the 
'setup.msi' file in the folder and continue the installation process once the 
Welcome screen appears.

         In the Welcome screen, click the Next button to continue.

1



Programming using the ASR-Soft

ASR-Soft provides a user-friendly interface wherein the user has to only select contact type and contact 
number and place it where it is required. Contacts get connected automatically if they are on the same line. 
User can enter comments for better readability and for future reference .

Entering the Program: Select & Place

ASR-Soft  allows user to save individual programs on the PC.
Saving Programs

ASR-Soft is very powerful in error handling. It displays any possible errors as the program is being entered 
to make corrections simultaneously.

Debugging

User can simulate the program on PC. User can use buttons provided on the screen to simulate the input 
connections. Scroll bar can be used to simulate Analog input. The actuation/ de-actuation of the relays can 
be monitored on the screen. 

Simulation on PC

User can take print outs of programs in two different formats, namely Short format and Detail format. Also, program Parameters and Comments can be printed.
Printing

Programs can be transferred from PC to Altech Smart Relay and vice versa using serial Communication cable / USB cable. This saves the program entering time on the Smart 
Transfering Programs

With this utility user can set the clock (date and time) on the Altech Smart Relay.
Transfering Clock

User can connect the Altech Smart Relay unit to PC using a serial Communication cable / USB cable and perform on line program simulation. In this mode the PC acts as a 
master and the inputs are taken from Altech Smart Relay and outputs are sent to Altech Smart Relay unit (and the extension modules, if connected). This mode is useful in 
debugging the entire system since the actual I/Os are used.

Simulation on Altech Smart Relay 

ASR-Soft is the exclusive Windows   based programming software for the Altech Smart Relay . It facilitates:

Select File -> New from the menu bar to create a new program.
A blank screen will appear. Now you can start entering the program. Ensure that you have chosen proper Altech Smart Relay Configuration before starting the program entry.

Position the cursor at the place where you want to insert the contact by a left click with mouse. The position will get highlighted. Choose the required contact type and Contact 
Number from I/O function selector. Click on the required contact and contact number, which will be highlighted for a few seconds. The selected contact will appear at the 
position selected in the program. The selected contact number will be shown with a tick mark to indicate that it has been used in the program. You can right click on any of the 
contact to change its type and properties.

Choosing Contact Type

Each circuit connection runs from left to right. Please remember this when you interconnect contacts and relay coils. User can draw a circuit connection horizontally from left 
to right and vertically between adjacent circuit connections. An intersection of circuit connections represents an electrical connection.

Connecting Inputs & Outputs

To make a horizontal connection, click on the horizontal dotted line in the connection box of the circuit. Or to make connection in contact box, press right button and select 
"Joining link". Generally when an output coil is placed in the fourth column, it gets automatically connected.

Horizontal connection

To make a vertical connection click on the vertical dotted line in the connection box of the circuit. Vertical connection represents OR connection. For deleting a connection 
just left click on the connection line.

Vertical connection

12

Program Editor
Window

Input/Output
Window

I/O Function
Selector Window

Error Window



Working with ASR-Soft

To Set Communication Parameters

Clock Setting

DST (Daylight Saving Time) Setting

Transfer Options
PC to Device

Device to PC

Extension Module Selection

To Configure Communication Port

To Set & Remove Password

Screen - 1

Screen - 2

Screen - 3

Screen - 4

Screen - 5

To Set Backlight Mode
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Ÿ Select the Configuration >Device Utilities menu command. Then Device Utilities window 
will pop up as shown in the Screen - 1

Ÿ Click on set password. 
Ÿ Enter four digits password in the two boxes “New password” and “Confirm New” 

Password then confirm with OK. 
Ÿ You can delete your assigned password at any time. To do this, enter the existing password 

in “Old password” box. Then confirm with OK.
Ÿ To change the password, you must first enter the new password in the two boxes “New 

password” and “Confirm Password “ and the existing password in Current password text 
box. Then confirm with OK.

Ÿ Select the Configuration >Device Utilities menu command. Then Device Utilities window 
will pop up as shown in the Screen - 1.

Ÿ Select the mode Auto, On or Off then click on the set mode button.
Ÿ Then “The requested operation will move the device out from the run mode. Do you want 

to continue?” message will pop up.
Ÿ If pressed Yes, then backlight mode will get set in device and "Backlight mode has been set 

successfully" message will appear on the screen.

Ÿ

up as shown in the Screen - 2 showing two option buttons to select the Port.
Ÿ Select “Device is connected to USB port” when the device is connected with cable.
Ÿ Select “Device is connected to Serial Communication port” when the device is connected 

with Serial Communication cable.

Select the Options > Comm port menu command. Then COM Port setting window will pop 

Ÿ

up as shown Screen - 2.
Ÿ The user can set the following communication parameters:
       SLAVE ID: Selectable from 1 to 247.
       BAUD RATE: Selectable as 1200,2400,4800,9600 baud.
       PARITY: Selectable as NONE, EVEN and ODD.
       STOP BIT: Selectable as 1 and 2 stop bits.

Select the Options > Comm port menu command. Then COM Port setting window will pop 

Ÿ

up as shown in the Screen - 3.
Ÿ To view Date and time of device: Click Read button on the clock setting window. Then the 

Clock Setting window will show the Date and Time of the device.  
Ÿ To set Date and time in the device: User can select Date and Time to write into the device. 

Click Write  button on the clock setting window.

Select the Transfer > Device Clock menu command. Then Device Clock window will pop 

Ÿ

up as shown in the adjoining window.
Ÿ To set Enable DST, Follow the following steps: Click Daylight Saving Time check box then 

the DST setting section becomes visible.
Ÿ User can select the following parameters: Begin Week, Begin Day, Begin Month, Begin 

Time, End Week, End Day, End Month, End Time, Offset Time 
Ÿ To set Disable DST, Follow the following steps:
      1. Deselect Daylight Saving Time option then DST window will get disable.
      2. Press Set DST.
Ÿ     To read DST: Press Read DST, independent of the DST enable or disable. 

Select the Transfer > Device Clock menu command. Then Device Clock window will pop 

Ÿ

in the Screen - 4.
Ÿ Press "PC to Device" button on transfer dialog box. Current program on the screen will get 

transferred to device.
Ÿ Transfer completion message "The Program is downloaded successfully" will appear on the 

screen. 

Select the Transfer > Program menu command. Then transfer window will pop up as shown 

Ÿ

in the Screen - 4.
Ÿ Press "Device to PC" button on transfer dialog box. Current program 

on the screen will get transferred to device.
Ÿ Transfer completion message "The Program is downloaded 

successfully" will appear on the screen. 
Ÿ Read program will be shown on main screen.

Select the Transfer > Program menu command. Then transfer window will pop up as shown 

Ÿ

Selection window will pop up as shown Screen - 5. 
Ÿ Selection of Altech Smart Relay model and Extension modules. 

Maximum three extension modules can be connected to one Base 
Module.

Select the Configuration >PLC Model menu command. Then Model 



Sample Programs

FACTORY/SCHOOL SCHEDULE
Opening bell at 8am announces start of work or class (bell to last 10 sec and stop): Bell at 10:30am announces start of coffee break, Bell at 10:45am announces end of coffee 
break, Bell at 12noon announces lunch, Bell at 12:45 announces end of lunch, Bell at 5pm announces end of work day

7. Select Timer T1 from the I/O selector window and place it in the coil column of line 1and contact column of line 7. 
8. Open the Timer properties window and select the mode as Interval and enter the time duration i.e. SP as 10 sec.
9. Connect the lines from all the Time Switches to the Timer as shown in screen.

10. Select Output Q1 from the I/O selector window and place it in the coil column
11. Right click on output Q1 to and select the option ‘State Change: Contactor’

1. Click on the Time Switch symbol in the I/O selector window and select Time Switch 1 (    1) 
2. Move the cursor to the ‘Contact 1' column of the first row and left click on the block to place the Time Switch.
3. Right click on the Time Switch and select properties to open the properties window.
4. In the Weekday settings option select ‘From’ as Monday ans ‘To’ as Saturday.
5. In the Daily Duration option enter the start time as 10:30 and since we want the siren for 10 sec. enter end time as 10:31.
6. Similarly select the other 5 Time Switches and enter the times as described above and place them in the contact 1 column of lines 2, 3, 4, 5 & 6.

Time Switch Selection  & Parameter Editing

Programming

Timer Selection  & Parameter Editing

Output Configuration

LADDER PROGRAM

For the 6 time periods 6 Time Switches are required.                         represent the 6 Time Switches.
Timer T1 ensures that the duration of the output is 10 seconds only.
Q1 represents the Output Coil (Alarm/Bell in this case)
Double click on the ASR Soft  icon the launch the ASR Soft  Software application.
Click on File   New to launch a new Program window.

 1,   2, .....   6
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Sample Programs

CAR PARKING
There are 5 parking spots available in a parking area. There are 2 sensors, one at the entry gate and one at the exit gate. When all the parking spots are occupied, there is a lamp 
outside the entry gate indicating parking is full. When any of the parking spots is available, other lamp is switched ON indicating parking is available. 

5.   Select Counter C1 from the I/O selector window and place it in the coil column of line 1. Right click on the counter and select the option counting input. 
6.   Again select the same counter C1 and place it in the coil column of line3 . Right click on the counter and select the option direction input. 

1.   Click on the Input symbol in the I/O selector window and select I1.
2.   Move the cursor to the Contact 1 column of the first row and left click on the block to place the input.
3.   Again click on the Input symbol in the I/O selector window and select ‘I2’.
4.   Move the cursor to the Contact 1 column of the second t row and left click on the block to place the input. Also place it in the Contact 1 column of the third row.

Input Selection

Programming

Counter Selection  & Parameter Editing

Compare Counter Selection  & Parameter Editing

Input I1is the sensor at the Entry gate and Input 2 is the sensor at the exit gate. 
Output Q1 indicates that Parking is available, Output 2 indicates that Parking is Full.
Counter C1 is used to count the number of vehicles that have entered or exited the parking.
Compare Counters P1 & P2 are used switch ON outputs Q1 & Q2 respectively  by  comparing the count of counter C1.

  7. Select Compare Counter P1 from the I/O selector window and place it in the contact column of line 4. 
  8. Right click on the compare counter and select properties. 
  9. Under the compare selection option, select ‘F1’ as ‘C1’, ‘OP’ as ‘<’, ‘F2’ as ‘Abs Value’ and reference count as 5. 
10. Select Compare Counter P2 from the I/O selector window and place it in the contact column of line 5. 
11. Right click on the compare counter and select properties. 
12. Under the compare selection option, select ‘F1’ as ‘C1’, ‘OP’ as ‘=’, ‘F2’ as ‘Abs Value’ and reference count as 5. 

13. Select Output Q1 from the I/O selector window and place it in the coil column
14. Right click on output Q1 to and select the option ‘State Change: Contactor’

Output Configuration

LADDER PROGRAM

15



Technical Specifications

ORDERING INFORMATION

ASR-E120AC

ASR-MC

ASR-RS232

ASR-USB

ASR-SOFT

ASR-C485-24DC

ASR-C485-120AC

ASR-E24DC

ASR-B24DC

ASR-B120AC

Supply Voltage

Analog Input Range

Digital Inputs

Digital Input Range

Outputs

Contact Rating

Input / Output Extension (Max)

Compare Counters

Lines for Ladder Programming

Auxiliary Relays

Analog Functions

Soft Text Messages

Counters (Up/Down, Retentive selectable)

Time Switches  (Daily/Weekly)

Timers

Power Reserve (For clock only)

Frequency

Supply Variation

Power Consumption

Analog Inputs

110 - 240 VAC

N.A.

8

(0 - 50 VAC) OFF, (80 - 265 VAC) ON

4

8A @ 240 VAC / 5A @ 30 VDC

250

64

N.A.

16 (Priority Driven)

16

16

16

16

150 h

Yes (3)

N.A.

N.A.50/60 Hz

-20% to +10%

~ 5 W

12 - 24 VDC

0 - 10 VDC

6

(0 - 4 VDC) OFF, (8 - 26.4 VDC) ON

4

8A @ 240 VAC / 5A @ 30 VDC

250

64

12

16 (Priority Driven)

16

16

16

16

150 h

Yes (3)

2 (Can also be used as Digital)

-20% to +10%

~ 5 W

110 - 240 VAC, Altech Smart Relay, Base Module

12 - 24 VDC, Altech Base ModuleSmart Relay, 

110 - 240 VAC, Altech Extension ModuleSmart Relay, 

12 - 24 VDC, Altech Extension ModuleSmart Relay, 

110 - 240 VAC, Altech RS 485 Communication ModuleSmart Relay, 

12 - 24 VDC, Altech RS 485 Communication ModuleSmart Relay, 

Memory Card

RS 232 Serial Communication Cable

USB Cable

Software supplied on CD-ROM compatible with Windows  98, 2000, XP,Vista & 7.
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Machine Controls
• Motor, pump and valve controls
• Air compressors
• Exhaust and filtering systems
• Water-treatment plants
• Woodworking machinery
• Etching and purification plants

• Energy management
• Heating Control
• Cooling systems
• Ventilation systems
• Air conditioning systems

HVAC Controls
• Conveyor systems
• Hoisting platforms
• Elevators
• Silo facilities
• Livestock feed delivery

Transport facilities

• Access control
• Vehicle control monitoring
• Alarm systems
• Level limit monitoring
• Traffic light control systems
• Baggage handling

Operational Monitoring Systems

APPLICATIONS

• Solar-electric systems
• Marine applications
• Harsh environments
• Display panels and traffic 
   control signs

Other Applications

• Interior and exterior lighting control
• Door/gate control
• Shutter, sun blind and awning control
• Irrigation system control

Residential and Commercial Building Services



Altech  Corp. USA :

Altech  Corp. Mexico :

35 Royal Road, Flemington, NJ 08822
908.806.9400
USA
www.altechcorp.com/smartrelay

Adolfo López Mateos No. 1321-A
Santa Cruz Buenavista
Puebla, Pue 72154
Mexico
01 (222) 226 70 37  
01 (222) 226 70 47 
www.altechmexico.com
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